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3D Visualization of DICOM images for Radiological applications

®

Following this tutorial, you
will be able to load and
visualize DICOM volumes
with 3D Slicer, and to
iInteract in 3D with structural
images and models of the
anatomy.
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N Overview

Part I: Introduction to the 3DSlicer software

Part Il: 3D Data Loading and visualization of DICOM images
- Volume Rendering of thoraco-abdominal CT data
- Surface Rendering of MR head data

Part lll: 3D interactive exploration of the anatomy
- Exploration of the Segments of the liver
- Exploration of the Segments of the lung
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N Overview

Part I: Introduction to the 3DSlicer software
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Introduction to the
3DSlicer software
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®

3DSlicer

Powerful processing. Streamlined interface. 1 Extensible platform.

3DSlicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3DSlicer is a multi-institutional effort
supported by the National Institute of
Health.
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®

3DSlicer

Powerful processing.  Streamlined interface. Extensible platform. ° 3DSI|Cer ve rS|0n 42 |S a mu|t|-
Ao e [ platform software running on
Windows, Linux, and Mac OSX

» Slicer is distributed under a
BSD license with no restriction
on use

« Slicer is a tool for research,
and is not FDA approved

Disclaimer _ _
It is the responsibility of the user of 3DSlicer to comply with both the terms of the license and with

the applicable laws, regulations and rules.
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An interdisciplinary platform

An open-source environment for An end-user application for
software developers clinical investigators and scientists

A software platform that is both easy to use
for clinical researchers and easy to
extend for programmers
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®

3DSlicer History

Image Courtesy of the CSAIL, MIT

1997: Slicer started as a
research project between
the Surgical Planning Lab
(Harvard) and the Computer
Science and Atrtificial
Intelligence (MIT)
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3DSlicer History

« 1997: Slicer started as a

@ Slicer 4 download statistics researCh prOJeCt between
o7 " Lo S the Surgical Planning Lab
46794 P
& (Harvard) and the CSAIL
pastyear |4 4] |
e gas D0 Sds. (MIT)
°°°°°° B , + 2012: Multi-institution effort

to share the latest advances
In Image analysis with the
clinical and scientific
community
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NA-MIC Wiki

General

Center Components
»Algorith
» 1

Resources

A multi-institution: NA-MIC, NAC, NCIGT

National Alliance for Medical Image Computing

A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

Modeling the path of the tamping iron through the Gage skull and its effects on white matter

structure Read more.
. .

el -

B/

The National Alllance for Medical Image Computing (NA-MIC) is a
multi-institutional, interdisciplinary team of computer scientists, software
engineers, and medical investigators who develop computational tools for
the analysis and visualization of medical image data. The purpose of the
Center is to provide the infrastructure and environment for the development
of computational algorthms and open-source technologies. and then
oversee the training and dissemination ~**=~=
research community.

10f 24 Photos

Supported by the National Institutes of

Information about collaborating with NA

xsNa2012 4

The 96th Annual
Meeting of the
Radiological Society of
North America will be
held on November
25-30, 2012 at
McCormick Place, in
Chicago, IL RSNA s an
international society of
radiologists, medical
physicists and other
medical professionals
with more than 50,000
members across the
globe

ORead more.

ONEWS ARCHIVE

Neuroimage Analysis Center

About the NAC

Resources

Pl: Ron Kikinis, M.D.

[l Prodicted {
B Actua i

The Neuroimage Analysis Center (NAC) develops image processing and analysis techniques for
basic and clinical neurosciences. The NAC research approach emphasizes both speciic core
technologles and collaborative appiication projects. The activities of the NAC are centered at the
Harvard Medical School and the Surgical Planning Laboratory at the Brigham and Women's

). with collaborators throughout the United States and the rest of the world

for research center supported by the National Center for Research Resources
r 2011) and the Institute of Blomedical Imaging and Bioengineering (NIBIB)
© National Institutes of Health

I

DYy S ¢

\»L CENp,
%‘5
%
&
‘7% b
"Ilmac
NCIGT Wiki
About Us
» Overview

» Research Labs
> Research Cores

Research
Projects

» DBPs
» People

Resources

» Publication DB

» Image Gallery

» Downloads

» AMIGO

> News and Events
» Contact Us

Advanced Multimodality Image Guided Operating (AMIGO) Suite
The Advanced Mulnmodallly Image Guided Operanng (AMIGO) Sulte |s an innovative

surgical and i that s the clinical st bed of the
National Center for Image-Guided Therapy (NCIGT) at the Brigham and Women s
Hospital (BWH) and Harvard Medical School. The AMIGO is an integrated, 5,700 square
foot area divided into three sterile procedure rooms in which a multidisciplinary team will
treat patients with the benefit of intra-operative imaging using multiple modalities. More.

© Featured Image Archive

The National Center for Image Guided Therapy (NCIGT) is a Biomedical
Technology Resource Center supported by the NCRR and NIBIB institutes

Pls: Ferenc Jolesz, M.D.,
Clare Tempany, M.D.
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Slicer: Behind the scenes

®

. —— Slicer is built every

e e |
n|ght on Windows,
. Mac and Linux

platforms

Windows7-VS2010-320its-QT4.7.1-PythonQt-With-Tel-CUI-

factory-win7 kaware 00 @
SnowlLeopard-g++4.2.1-64bits-QT4.7-PythonQt-With-Tck-CU-
factory-mac-64bits. kitware R D@

Linux-ge+4.4.3-64bits-QT4.7-PythonQt-With-Tel-CLI-Release
P
Windows7-VS2008-64its-QT4.7.1-PythonQt-With-Teh-CLI-
Release &

S: QT4.7.1-PythonQt-With-Tel-CU-
Release ¥«

factory-ubuntu-64bits. kitware

factory-win7 kaware 10003

factory-win7 kaware

Suld Neme Buld Time.
t Wogccaon«,.r.ommwm-mmuu 11 hours ago

youplsclutah.edu ’mcm.a.o«mnm-wm-rm~ FEe
ers aware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release & $hours ago
r~—y ’L:Xwg.mn.vmmuwu-vwmm 11 hours ago
factory-bun-Sibkaxtwere Linux-g++4.4.3-6415-QT4.7-PythonQt-With-Tel-NoCLI- 11 hours ago

Coverage-Reloase ‘A
Linux-g++4.3.3-QT4.7-PythonQt-With-Tc-NoCLI-Release

sagarmatha. kitware

Buid Name

OpenSuse-C++4.5.0-64bits-QT4.6.3-PythonQt-With-Tel-NoCLI-
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Slicer Training events

l .
[
3 h |
i "
‘

Hands-on training
workshops at national
and international venues

More than 2,000
clinicians, clinical
researchers and
scientists trained since

2005
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Slicer Training events

, :
.
D f) |
i . [
‘

— RSNA 2008, 2009, 2010,
2011, 2012

— MICCAI 2008, 2009, 2011,
2012

— SfN 2009, 2011

— SPIE 2012, 2013

— CAOS 2010

— CARS 2010, 2012, 2013

RSNA 2011
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ﬁ) RSNA Activities

Hands-on refresher courses

« 3D Visualization of DICOM images for Radiology Applications
« Quantitative Imaging for Clinical Research and Practice

Quantitative Imaging Reading Room Exhibit

« 3DSlicer: An Open Source Platform for Segmentation,
Registration, Quantitative Imaging, and 3D Visualization of
Multi-Modal Image Data. #3007
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N Overview

Part Il: 3D Data Loading and visualization of DICOM images
- Volume Rendering of thoraco-abdominal CT data
- Surface Rendering of MR head data
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Welcome to Slicer

00

3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
& |Modules: 2\ Welcome to Slicer 3| - PO a4 2 % B W %
1 &
;\ Slicer
e

Gy Load DICOM Data ey Load Data
#: Customize Slicer @ Download Sample Data
» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

To start Sliggr, select Start 2> Programs—> Slicer4-2.0 (win64)

L
F
B
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Navigating the Application GUI

The Graphic User
Interface (GUI) of Slicer4
integrates four
components:

the Menu Toolbar

the Module GUI Panel
the 3D Viewer

the Slice Viewer

+ o .Menu &:Toolbar

g
(s
=4
siss) Load DICOM Data
& Customize Slicer ©
L]
— 3D Viewer
nd S
ard
itorials
» Acknowledgment
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ACPC Histogram Matching 4 Transforms
View Help Add Scalar Volumes Image Label Combine Vector Demon Registration (BRAINS)
é Modules: . | Welcome to Slicer Affine Registration Intensity Difference Change Detection (FAST) Vector to Scalar Volume
All Modules @2 :t:no(ations Label Map Smoothing I View Controllers
1 ) tlasTests Label Statistics ViewControllers Sli i
Q 3DSlicer f 3:::8"""5 BSpIine Dsfomablg ngismnlion Ia.beIToggIe.Bugz_Ms ® Volume Rend;:nsgllcs Interpolation Bug 1926
BSpline to deformation field Linear Registration
& DICOM @ Cameras Mask Scalar Volume @ Volumes
N N N Voting Binary Hole Filling Image Filter
We I Co n ~ Editor Cast Scalar Volume Median Image Filter WebGL Export
© Models ChangeTracker Merge Models 2\ Welcome to Slicer
- # Scene Views Charting Model Maker
| s Load DICOM Data | « CheckerBoard Filter Model To Label Map
[ = Slicer | view C ® Colors © Models
© Volume Rendering Create a DICOM Series Multiply Scalar Volumes
» About @ Volumes @ Crop Volume MultiVolumeExplorer
—— It Curvature Anisotropic Diffusion MultiVolumelmporter
jalhio MainWindow, o o Steer 4 Data NA4ITK MRI Bias correction
3 loadngand Saving |  Mzards DataProbe 3¢ OpenlGTLInkIF
o Demon Registration (BRAINS) Orient Scalar Volume
» Display | :99'5“'3"";‘ 5 DICOM Otsu Threshold Image Filter
ok oaton DICOM to NRRD Converter Otsu Threshold Segmentation
Diffusion Diffusion Tensor Scalar Measurements Performance Tests )
aT Diffusion Weighted Volume Masking PET Standard Uptake Value Computation
—— DTlexport Probe Volume With Model
» Acknowledgment s rlaeg Model DTlimport % Reformat
1 C:nverlers el DWI Joint Rician LMMSE Filter Resample DTI Volume
Endoscopy DWI Rician LMMSE Filter Resample Image (BRAINS)
Utilities DWI to DTI Estimation Resample Scalar Volume
Developer Tools DWI to Full Brain Tractography Rfegample_ Sca!arNemorlDWl Volume
Legacy DWI Unbiased Non Local Means Filter Rigid Registration
Testing ~ Editor Robust Multiresolution Affine Registration
EMSegment Command-line Robust Statistics Segmenter
Work in Progress M with Atlas RSNA2012Quant
& EMSegmenter without Atlas RSNA2012Vis
(Issue 2428)
n Growing Segmentation
ic
-ashBug2590
lar Volumes
-alar Volume
Display
Interactive Seeding
Label Map Seeding
ML Files to New EMSegmenter Standard
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ACPC Transform General Registration (BRAINS)
Add Images Gradient Anisotropic Diffusion Statistics Segmentation
2 Annotations Grayscale Fill Hole putation

BSpline to deformation field Grayscale Grinid Peak B
Gameras Grayscale Model Maker ~ Scene Views

Cast Image Histogram Matching Simple 10 Test
ChangeTracker Image Label Combine Simple region growing
CheckerBoard Filter Intensity Difference Change Detection (FAST)
Colors Joint Rician LMMSE Image Filter

Create a DICOM Series Label Map Smoothing
Crop Volume Label Statistics oT

Curvature Anisotropic Diffusion Lingar registration
DICOM MR Bias Field Correction

DWI to Full Brain Tractography :""5“ :"‘39: T Tractography Labelmap See
a ISR TONT DNTOSTON YYOTgTog Arges Transform MRML Files to N

EMSegmenter Standard i

Transforms
Unbiased Non
§ View Controllers
ements o " @ Volume Rendering
‘ommand-iine " @ Volumes g
i EMSegmenter with Atlas ‘ Voting Binary Hole Filling b7
& EMSegmenter without Atlas Welcome 1o Slicer
Editor
Endoscopy
Event Broker
Execution Modei Tour o S i
Expert Automated Registration S ! £
Extract Skeleton
Fast Affine registration o e Vot Mol (Pain) e
Fast Nonrigid BSpline registration ’ W
on o !
fon

ng (BRAINS)

Al Means filter for DWI

Resampl
Resample Scalar Volume

Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Slicer4.2 contains
more than 100
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data
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Loading a DICOM Volume

Slide 21

©2012-2013 Surgical Planning Laboratory, ARR



Loading a DICOM volume

FEile Edit View Help

ga Modules: . |iWelcome to Slicer 1m0 Q0I9 O @@ t - Ao Fa | 4 v
ox [l
e wwwwww ‘ ‘
Welcome

-l . Click on Load DICOM

g’ Load DICOM Data
# Customize Slicer

» About
»S{e Main Window

» Loading and Saving

Welcome to Slicer

» Mouse & Keyboard

» Documentation & Tutorials m Od u Ie

» Acknowledgment
L N

EREX §:0.00] -

Y & R:0.00 |8 G &

~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),

Data in the panel of the
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Select DICOM local database

3D Slicer 4.2.0

File Edit View Help

Ea |Mooues: . [ picom " Q0P O @@ s
1

@ 3DSlicer 800 DICOM Details
> =
Import Export Query Send Remove LocalDatabase: | I A jol/Pujol2012/Quantitat ing_Sunday_Nov25_2012/dicom-database
‘ > Help & Acknowladgement __| Name 4~ Age Scan Date Subject ID Number Institution Referrer Performer
| » senvers
( Start Listener
Start Listener when Slicer Starts
| ¥ DICOM Database and Networking
( Show DICOM Browser
| * Recent DICOM Activity
0 series added to database in the past hour R |
DICOM Data Reader Warnings
[ Refresh
v Data Probe
Il [ [*)
L q ol Uncheck Al | Load Selection to Slicer
E I Make DICOM Browser Persistent

The GUI of the DICOM browser window appears
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Select DICOM local database

8 00

Import Export Query Send Removeﬁ
Name ~ Age Scan Date Subject ID  Number

The path to the current local DICOM database of Slicer is set to
C:/Pujol2012/Quantitativelmaging_Sunday Nov25 2012/dicom-database

®

gCa ataba\ 7 /Users/spujol/Pujol2012/Quantitativelmaging_Sunday_Nov25_2012/dicom-databa

itution  Referrer Performer

DICOM Data Reader Warnings

Uncheck All | Load Selection to Slicer || Close |
Make DICOM Browser Persistent 24

(o []




Select DICOM local database

®

0.0.0 DICOM Details
Import Export Query Send Remove LocaIDataba[E/Users/spujollPuiol2012/QuantitativeImaging_Sunday_Nov25_201Zdice?
Name +~ Age Scan Date Subject ID  Number Institution  Referrer Performer
006 i Dioecion 1

[« )[z B @ m [ =~ | (& Pujol2012 &) (G )

FAVORITES

v [ Quantitativelmaging_Sunday_Nov25_2012

Dropbox
E P _ » [ dicom-database
= All My Files » [ dataset3_PETCT
ﬁ Applications » [ dataset2_ChangeTracker
Desktop » [ datasetl_MR-Head
v im *~n_Tuesday_Nov27_2012
lﬁ Documents -
L] dicom-dataB
0 Downloads » [ dataset4_CT-C|

» [ dataset3_CT-Livé
» (] dataset2_MR-He
(] datasetl_CT-Tg¥rax-Abdomen

751 spujol

SHARED

Warnings

DEVICES

) Remote Disc

New Folder




Loading a DICOM volume

DICOM Details

Impo Export Query Send Remove LocalDataba[EIUserslspujol/Pujolzm2/3DVisualization_Tuesday_Nov27_2012/dicom—database
Name §~ Age Scan Date Subject ID  Number Institution  Referrer Performer

Reader Warnings

[+]
& Import

[impor]

Uncheck All ]| Load Selection to Slicer | Close J
[ ' Make DICOM Browser Persistent
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Loading a DICOM volume

Eile Edit Vi
23 |Mocues: [ picom = Q0.0 9O e« d s $ - fa Fa
e Bl

Select the directory dafaset1_CT-Thorax-Abdomen
Click on Import to load the dataset into Slicer

9t
28
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Loading a DICOM volume

DICOM Details

Import Export Query Send Remove LocalDat:#i/Users/spujol/workshop/RSNA2012/data/DICOM-database|

Name ~ Age Scan Date Subject | Number | Institutiol Referrer Performer
= patient1 patien...
= CT Thorax Abdomen 2005-... 6936864 oEfZQ...
CT_Thorax_Abdomen CT 6 2005-... HEART 14
« | )
DICOM Data Reader Warnings

| UncheckAll | Load Selection to Slicer | Close

. ' Make DICOM Browser Persistent
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Loading a DICOM volume

8 00 mmﬁil
Import Export Query Send Remove LocalDats| #/Users/spujol/workshop/RSNA2012/data/DICOM-database
Name ~ Age Scan Date Subject | Number Institutiol Referrer  Performer
= patient1 patien...
= CT Thorax Abdomen 2005-.... 6936864 oEfZQ...
CT_Thorax_Abdomen CT 6 2005-... HEART 14

Image 2 Image 3 Image 4
- q - q - d
Ima!e 5 Ima!e 6 Image 7 Image 8 Image 9

Image 10 Image 11

Image 15 Image 16 Image 17 Image 18 Image 19

leader Warnings

| v6: CT_Thorax_, Abdo... Scalar Vol...

: CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT Thorax Abdo... Scalar Vol...

DDDDDDDDDDDDD D C

GI

l

Uncheck All || Load Selection to Slicer ||

Close

GL

I

—_—

Make DICOM Browser Persistent
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Loading a DICOM volume

8 00 Dnnils
Import Export Query Send Remove LocalDats| #/Users/spujol/workshop/RSNA2012/data/DICOM-database
Name ~ Age Scan Date Subject | Number Institutiol Referrer  Performer
= patient1 patien...
= CT Thorax Abdomen 2005-.... 6936864 oEfZQ...
CT_Thorax_Abdomen CT 6 2005-... HEART 14

1)

ICOM Data Reader Warnings
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
Thorax_Abdo... Scalar Vol...
6: CT_Thorax_Abdo... Scalar Vol...
~6: CT_Thorax_Abdo... Scalar Vol...
6: CT_Thorax_Abdo... Scalar Vol...
116: CT Thorax Abdo.. Scalar Vol

Image 15 Image 16 Image 17 Image 18 Image 19 ol Uncheck All Load'éelection to Slicer | Close
o " Make er @sistent

GI
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Loading a DICOM volume

800 3D Slicer 4.2.0-rc1-2012-10-28 ]
File Edit View Help
ga & Modules: . @ DICOM |-

e®
\@ 3Dslicer

» Help & Acknowledgement

OO IO e« <« It -8 = -
1

~ Servers

Start Listener J
Start Listener when Slicer Starts
~ DICOM Database and Networking
Show DICOM Browser
~ Recent DICOM Activity

1 series added to database in the past hour
Today: CT_Thorax_Abdomen for patient1

Refresh

-~ Data Probe J ;

Slicer displayé_fr_lé'axiél, -C(-)ernal and
sagittal slices of the DICOM dataset
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Loading a DICOM volume

806 3D Slicer 4.2.0-rc1-2012-10-28

FEile Edit View Help

g2 % & |Modules: - [=DICOM " QO0 |9 «@ <2 Bt 8 w -
ox [l

@ 3DSlicer

» Help & Acknowledgement

~ Servers

Start Listener J

Start Listener when Slicer Starts
~ DICOM Database and Networking
Show DICOM Browser J
~ Recent DICOM Activity

1 series added to database in the past hour
Today: CT_Thorax_Abdomen for patient1

~ Data Probe

| Red RAS:(-79.4,290.2,-188.5) Axial Sp: 2.0
L None 0

F None

0
B6: CT_Thorax_Abdomen (426, 17, 145)-956
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Loadlng a DICOM volume

gdn View Help
&a g Modules: . @ Volumes (" Q0O IPO @@ v t Ao R,
o® |

mfe
B3 >

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

o NG : Slicer has a series of
QA@, | a window/level presets
ThreshoAId: o off - . available

» Help & Acknowledgement 3 ‘ ‘

i
-1434

W:350 I/ Manual W/L +||L:40
» Histogram

Click on the Window Level
Preset CT-abdomen, or
adjust manually the Window
and Level using the Manual

WI/L slider
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Loading a DICOM volume

F|Ie Edn View Help
g2 2 2 Modules: . @Volumes

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

Position the mouse cursor
over the red banner in the
Red Viewer to display the
slice menu.

Click on the Links icon &,
to link the slice controls
across all Slice Viewers.
Click on the Eye icon to
display the three anatomical
slices in the 3D Viewer

=00 9O ed < tv| @ M R4

ox @1

Link/Unlink the sl|ce

controls (except
Pascales) across all

Slice Vi

_/, ARR
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°/) Loading a DICOM volume

00

(2]

File Edit View Help

ga & & |Modules: . @Volumes = Q. PO ed 2 t - Ao R,
1

@,s \\\\\

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table:| ¢ Grey

Interpolate: v
Window Level editor presets:

Wil @ a

W:350 7/|Manual W/L +||L: 40
Threshold: Off ¢
-1434 3480 . =T

N 6:CT...domen =

The three anatomical
slices appear in the 3D
viewer. Use the right-
mouse button in the 3D
Viewer to zoom in and out
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help

g3 & & Modules: .| @Volumes (" Q0O PO @@ 2 HIt @ W 5 -

Q 3DSlicer

» Help & Acknowledgement
Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table: [lF Grey

Interpolate:  ~
Window Level editor presets:

Wi B @ A

W:350 I/|Manual W/L +||L: 40
Threshold: Off <
-1434 20 113480 .

Use the left-mouse button
in the 3D Viewer to rotate
the 3D volume

wmr

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

.00 30 Slicer 4.2.0-1c1-2012-10-28 ]
File Edit View Help
% |Modules: . |® Volumes s - /Bt~ 8 M |+~
P fos
Q s0slicer R L [[Center the 3D
view on the scene
» Help & Acknowledgement S =
-

fps

R L 9|p Qe

EEIEd

A [a|ca

O

Axial +/6: CT...dom,

~ Data Probe

wnr

|-
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga £a 'Modules: . '@ Volumes

@ OSlicer

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display gl | i
Lookup Table:[ I Grey N & Red slice only ‘,
. = Yellow slice only
Interpolate: v . A
Window Level editor presets: B Green slice only
Tabbed 3D

= Tabbed slice

Click on the Slicer layout T |
menu icon, and select the  gggg-roe o
Conventional Widescreen

layout

~ Data Probe

wmr
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Loadlng a DICOM volume

Use the red ~00 00 s e mIimnn
slice, yellow =
slice and green
slice slidersto
slice through the
volume in all
three anatomical
directions

~ Data Probe

L
E
B
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3D Interactive exploration of
thoraco-abdominal CT data
using Volume Rendering
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Volume Rendering

®

800 3D Slicer 4.2.0-rc1-2012-10-28
Eile Edit View Help

£a 'Modules: . |® Volume Rendering = QO I9O @@ ~ H|t 8 & R+
e IS

@ 3DSlicer

» Help & Acknowledgement

«Volume: [6: CT_Thorax_Abdomen
» Inputs

~ Display
Preset: Select a Preset B
Shift:

Select thé m—o“dulél Volume
Rendering in the modules
menu

~ Data Probe

wnr
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Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

8006
File Edit View Help
g |Modules: .| ® Volume Rendering " QOIPO @@ < | EHIt -8 w fal b~

CEY

!B= 30Slicer
-

» Help & Acknowledgement

\
«Volume: [6: CT_Thorax_Abdomen 3
» Inputs \

\

~ Display
Preset: Select a Preset s
Shift:

Select thé vdlﬁme
6:CT_Thorax_Abdomen

~ Data Probe

wnr
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®

Volume Rendering

800

Eile Edit View Help

& & Modules: . |®Volume Rendering "m0 O IV «@d 2| H BN
O® 1@

Q 3DSIi

» Help & Acknowledgement

«+Volume: [6: CT_Thorax_Abdomen
» Inputs

~ Displa

y
Preset: % m ‘ ! . . B
Shift: y =
L ,
Rendering:@ l .- l o |E
» Advance @ - |

Click on Preset in the Display ™
tab to display the list of available
presets for the transfer function b Eow
Select the Preset CT-Cardiac3 - S—




Volume Rendering

800 2.0-rc1-2012- 8
File Edit View Help
# & Modules: . |®Volume Rendering = Q. PO« ~ %
ox M1 &
@ Slicer

» Help & Acknowledgement

«~Volume: |6: CT_Thorax_Abdomen
» Inputs

~ Display

Preset: @ CT-Cardiac3

Shift:

Crop: Enable <+ Di Ol |&Fit to Volume

Rendering:|NCI GPU Ray Casting

Select the Rendering VTK
CPU Ray Casting, and
click on the eye icon in the
Volume tab to display the
Volume rendered volume
in the 3D viewer
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Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

File Edit View Help
# Modules: . @ Volume Rendering =00 19O «@ <« |EHlt- e Fa

Q 3DSlicer

» Help & Acknowledgement

= \olume: |6: CT_Thorax_Abdomen i
» Inputs

~ Display

Preset: @ CT-Cardiac3 B
Shift:
Crop: Enable «Display ROl |+ Fit to Volume|
Rendering:NCI GPU Ray Casting C

» Advanced...

Slicer displays the 3D
rendered volume of the

CT _Thorax_Abdomen dataset
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Volume Rendering

800 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga g /Modules: . ®Volume Rendering (= Q. 0

e® b

PO ed v t @ A R

E 3DSlicer

» Help & Acknowledgement

#\Volume: 6: CT_Thorax_Abdomen ¢
» Inputs

~ Displa

- @ CT-Cardiac3 o
Shift: — :
Crop: v Enable = Display ROl | #Fit to Volume
gndering: NCI GPU Ray Casting E

Move the Shift slider

toward the right, to

shift the transfer

function and display
_ the aorta
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Volume Rendering

8 00 3D Slicer 4.2.0

File Edit View Help

@ Modules: \‘[.VulumeRendering ¢‘ - 0 o a 56 L a 7.

e @i
@ 3DSlicer
o

» Help & Acknowledgement

tvkb&v.é?‘v

+# Volume: [6: CT_Thorax_Abdamen

|
|
¥ Inputs ‘
|

¥ Display

Preset: ‘ @ CT-Cardiac3 3 ]
Shift: E

Crop: Enable 4. Display ROl l @Frl to Volume

Rendering: | VTK CPU Ray Casting )

> Advanced... ‘

The volume rendered image
of the aorta and rib cage
appears in the 3D viewer
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Volume Rendering

8 00 3D Slicer 4.2.0

®

lle Edit View Help

Click on the eye icon —_—
In the red viewer to
turn off the visibility of
the anatomical slices

in the 3D viewer
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Volume Rendering

Use the mouse in the -
3D window to rotate
the volume rendered

Image

00 Slicer 4.2.0-rc1-2012-10-28

I |®

ile Edit View Help

B

a®

Q 30Slicer

~ Data Probe

L
F
B

& Modules: . | ®Volume Rendering =009 e«@ 2« | H|t-8 A
1@
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Volume Rendering

806 3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help

ga 2 2 Modules: . |® Volume Rendering "0 0190 &« @ < t-8 A
2® b

@ 3DSlicer

» Help & Acknowledgement

= Volume: |6: CT_Thorax_Abdomen
2 » Inputs

~ Display

Preset: @ CT-Cardiac3
Shift:
Crop: Enable < Display ROl | #Fit to Volume |
Rendering: NCI GPU Ray Casting s
» Advanced...

Click on the eye icon

In the volume

rendering panel to
remove the volume
rendered image from

the 3D viewer
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Volume Rendering

800 3D Slicer 4.2.0
File Edit View Help
7?@@7Wdules:w\[.\folumeRendering ¢l-,°v07°6 E e 77"7! =% Ehv’.é,v

@ 3DSlicer

) Help & Acknawledgement ]

4. Volume: |6: CT_Thorax_Abdomen s

J
» Inputs J
¥ Display ]
Preset: [ @ CT-Cardiac3 i ]
Shift: &
Crop: 17 Enable +. Display ROI
Rendering: [VTK CPU Ray Casting 3

» Advanced...
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Volume Rendering

8 00 . — . — . — . — . 3D Slicer 4.2.0 . "

File Edit View Help

’@ @ Modules: .| @ Volume Rendering tl - ev o ‘ 0 & @ 7. t v @ & Ehv E
ax B

@ 30Slicer

» Help & A

4 Volume: | 6: CT_Thorax_Abdomen

» Inputs

The region of interest
appears in the 3DViewer
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Volume Rendering

8 00 3D Slicer 4.2.0

File Edit View He
@ Modules: :Iovmumeﬂsndenng 3‘ -v Q- ‘) w D % E Z t- Ra &v ’%kv
e i
" !‘= 3DSlicer
4
¥ Help & Acknowledgem ‘

Position the ROl around the
left and right kidneys using
the ROI controls in the 2D
anatomical views and in the
3D viewer
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Volume Rendering

/

600 3D Slicer 4.2.0
File Edit View Help

&a @ | Modues: . | @ Volume Rendering B - 0‘ QP O @ Z
18

B®
@ 3DSlicer

» Help & Acknowledgement

% Volume: |6: CT_Thorax_Abdomen
» Inputs

“

¥ Display

Preset: @ CT-Cardiac3 3 ]
Shift: g
Crop: | Enable & Display ROI

©2012-2013 Surgical Planning Laboratory, ARR

Slide 54



Volume Rendering

800 3D Slicer 4.2.0

File Edit View Help
@ Modules: ;;‘.Vo\umeRendering ¢‘ -‘ Qv o a Q % E Z t - B 5 ghv «%.v
B® 1 [
@ 3DSlicer
vl
P Help & Acknowledgement

4 Volume: | 6: CT_Thorax_Abdomen

+ Enable isplay ROI ‘ {E-Fit to Volume ‘

Slicer displays the volume
rendered image of the left
Kidney
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Volume Rendering

3D Slicer 4.2.0

8 0 O
File Edit View Help

@ Modules: ,,‘.Volumenenderir\g C‘ -v ov Q a 0 L E 7 t~ =Y Ehv *‘i‘"
18

@®
@ 3DSlicer
>

» Help & Acknowledgement

|
@ Volume: [g: CT_Thorax_Abdomen 2]
J
J

j e
~ Display
- Y @ == R -66.37
p .

Preset: [.cT—Cardiac:i J ‘ L
¥, ! Wt
. £

Shift:
£+ Fit to Volume

Crop: | Enable 8 Display ROI

Rendering: | VTK CPU Ray Casting > J

» Advanced... ]

Extend the ROl to the
right kidney
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Volume Rendering

00 1
FEile Edit View Help
ga & 2 Modules: . ®Volume Rendering =0 Q0 9O e« 2 Bt~ e Fa |4~

es @1 E

» Help & Acknowledgement

= Volume: |6: CT_Thorax_Abdomen
» Inputs

~ Display
Preset: @ CT-Cardiac3
Shift:

Crop: v Enable = Display ROl |#Fit to Volume
Rendering: NCI GPU Ray Casting Z
» Advanced...

Slicer displays the
cropped volume rendered
images showing the left
and right kidney

F
B
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Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

(o)

[s)
ile Edit View Help
&a & & Modules: . ®Volume Rendering (=0 QPO & s tv @ G|+
CE] 8

!b= 3DSlicer
v

» Help & Acknowledgement

m®

»

=\Volume: 6: CT_Thorax_Abdomen ¢

» Inputs

~ Display

Preset: @ CT-Cardiac3 D
Shift:

Crop: v Enable « Display ROl | Fit to Volume |
Rendering: NCI GPU Ray Casting g »
» Advanced...

Click on File>EXxit to quit
Slicer

~ Data Probe

wnr
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3D visualization of surface
models of the brain
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ﬁ' 3D Data Loading and Visualization

* This tutorial is a short introduction to the
advanced 3D visualization capabilities
Slicer

» The Slicer4 Minute dataset is composed of an
MR scan of the brain and 3D surface
reconstructions of anatomical structures.

* The data are part of the SPL-PNL Brain Atlas
developed by Talos, Jakab, Kikinis et al. The
atlas is available at:

http://www.spl.harvard.edu/publications/item/view/2037
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®

Slicer4 Minute Tutorial: Viewing the Scene

= 0 Q.
®

Welcome

PO ad 2 o HI LB @ B+~
® HE

When the scene is finished loading,
Slicer displays:

*a 3D model of the head in the 3D
Viewer, and

*anatomical MR slices of the
brain in the 2D Slice Viewers.

kkkk
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Slicer4 Minute Tutorial: Exploring Slicer’ s functionality

800, |  ACPC Transiorm Linear Registration i
File Edit View Help | Add Scalar Volumes Mask Scalar Volume
& |Moduies: -, [\ Weloome to Sicer E il Hedian mage Fite
AtasTests Model Maker
@ Annotations BSpline Deformable Registration Model To Label Map
3DSlicer 4 Data BSpline to deformation field
£ DICOM @ Cameras Multiply Scalar Volumes
~ Editor Cast Scalar Volume MultiVolumeExplorer
We | C O r © Models ChangeTracker MultiVolumelmporter
R Scane Views Chartipg N4ITK MRI Bias correction
|4 Transoms L erBonrd e 3¢ OponlGTLIF
Losd DICOM BY E Vew ‘(;D:nggﬂer;ng Create a DICOM Series Otsu Threshold Image Filter
< @ Crop Volume Otsu Threshold Segmentation
j‘ Volumes Curvature Anisotropic Diffusion Performance Tests
|2\ Welcome to Slicer 4 Data PET Standard Uptake Value Computation
o access the Models - " daapoe Fee e Vot
S Wizads ,|  Demon Registration (BRAINS) @ Reformat
~—| Informatics »|& DICOM RegAladin
~ | Registration »|  DICOM to NRRD Converter Resample DTI Volume
m o u e rowse | Segmentation »  Diffusion Tensor Scalar Measurements Resample Image (BRAINS)
b} Quantification »|  Diffusion Weighted Volume Masking Resample Scalar Volume
___| Diffusion »|  DTIChallengeExplorer Resample ScalarVector/DWI Volume
- IGT »|  DTlexport Rigid Registration
ro u h th e I I St Of Fitering »|  DTlimport Robust Muliresolution Affine Registration
s | Surface Models »  DWI Joint Rician LMMSE Filter Robust Statistics Segmenter
1 Converters »|  DWIRician LMMSE Fiter RSNA2012ProstateDemo
| Endoscopy »|  DWIto DTI Estimation RSNA2012Quant
l I IO u eS Utiities »|  DWIto Full Brain Tractography RSNA2012Vis
mE= Developer Tools »|  DWI Unbiased Non Local Means Filter & Sample Data
Legacy »| 2 Editor Scene Import (Issue 2428)
Testing »|  EMSegment Command-ine sa Scene Views
Work in Progress | i EMSegmenter with Atlas SelfTests
‘" without Atlas Simple Region Growing Segmentation
Endoscopy SiiceLinkLogic
1 Event Broker SiicerdMinute
.. o r C I C O n e Execution Model Tour slicerCloseCrashBug2590
Expert Automated Registration Subtract Scalar Volumes
Extract Skeleton Threshold Scalar Volume
fiber_visibility_crash2438 Tractography Display

models icon ; e Taciogaghy Iasiis Seedng
Foreground masking (BRAINS) Tractography Label Map Seeding

Gaussian Blur Image Filter Transform MRML Files to New EMSegmenter Standard

] General Registration (BRAINS) 4% Transforms
I n th e too I ba r Gradient Anisotropic Diffusion Vector Demon Registration (BRAINS)
Grayscale Fill Hole Image Filter Vector to Scalar Volume
Grayscale Grind Peak Image Fier I View Controllers
Grayscale Model Maker ViewControllers Siice Interpolation Bug 1926
Histogram Matching ® Volume Rendering
Image Label Combine @ Volumes
L Intensity Difference Change Detection (FAST) Voting Binary Hole Filing Image Filter
3 Label Map Smoothing WebGL Export
Label Statistics B\ Welcome to Slicer
labelToggleBug2049
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Slicer4 Minute Tutorial: Switching to the Models Module

e fON W/

®

3D Slicer 4.0.gamma-2ZUL1-11-14
& & |Modules: . [@ Models = Q0O I ® @ & §HE «

ex [l
@ 3DSlicer

| » Help & Acknowledgement 1|
= Scene

= hemispheric_white_matter.vtk 1.00
» left_eyeball.vtk H 100
» optic_chiasm.vtk 1.00
» optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
» optic_tract_R.vtk 1.00
= right_eyeball.vtk W 1.00
» Skin.vtk 1.00
= skull_bone.vtk 1.00

| Information

|~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:

v

|~ Data Probe

wmrr



Slicer4 Minute Tutorial: Basic 3D Interaction

®

e @l W) 3D Slicer 4.Uu.gamma-ZULl1-11-14

& % [Modules: . |@ Models = 0O IO @« &4 §E 2 [F‘ 4 v Persistent Ao R | 4

@ 3DSlicer
v

| » Help & Acknowledgement

- Scene
B V) 4 1.00
Position the mouse - 1;§§
in the 3D Viewer. 1;§§
ot
1.00

Hold down the left

mouse button and
drag to rotate the

model.

wmrr




Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @ ) 3D dlicer 4.Uu.gamma-ZUll-11-14

@ & |Modules: . |@ Models \- COINMO® &« 4§ 2 H m t v Persistent | @ Ao Fa | 4~
B® FIRI L] .00
olm @A o)m
@ 3oslicer : 1001 )@@ None 2]
@ g “ g8 |None B
|» Help & Acknowledgement E|
[:|grayscale

= Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk

Click on the Slice Visibility
o icon

||
Sl
88888888&8

to display the Axial Slice in
the 3D Viewer

wmr

WLV I £=£V 10 oulyival rialiiily Lavuiatul y, AN IIUT UV



Slicer4 Minute Tutorial: 3D Visualization

Slicer adds a view of
the Axial slice in the
3D View.

©2012-2013 Surgical Planning Laboratory, ARR Slide 66



Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @ W) 3D Slicer 4.U.gamma-2ZUL1-11-14

@ & |Modules: . |@ Models = 0O IO @& &4 @ @ 2z @ t - Persistent | @ Ra Ra | 4~
o [Hi oli] ————8—————ELN
O [® i |Adal 2 EB %, -
@ 30Slicer 00T @ None %)
» n | B |None s
\ _ :z:; : Acknowledgement H 0 v@l grayscale )
= hemispheric_white_matter.vtk .00
= left_eyeball.vtk [ | 1%
Click on the layout menu in | %
the toolbar, and select the = i3
= 1.00
Conventional layout ¥
. |
Visible:
Selected:
Clip:

Slice Intersections Visible:
v

|~ Data Probe

L
F
B

WLV I £=£V 10 oulyival rialiiily Lavuiatul y, AN INU<T v17s



®

Slicer4 Minute Tutorial: 3D Visualization

Select the Skin.vtk

Change the opacity of the model from

1.0 to C.0.

» Help & Acknowledgement

ne
# hemisphel hite_matter.vtk 1.00
* left_eye M 100
* optic_ Vi 1.00
 optic_n¢ i 1.00
* optic_ne WV 1.00
® optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball. vtk B 100
# skul_bone.vtk 1.00
» Informati
¥ Display
Visible: v
Selected:
Clip:
Slice Intersection: ibl
W Matasialnes,
Zolor:
dpacity: _— ‘1.00 B
\mbient: (000 2] [

CO IO & 2 @& ~ ‘E‘tvp sssss et | @ e S,

4

i v

¥
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®

Slicer4 Minute Tutorial: 3D Visualization

and eyeballs become visible -

through the model of the skinin

the 3D viewer.

(skin model opacity = 0.5) -

Clip:

Slice Intersections Visible:
v Material Properties

Color:

The model of fhe skull bone

s _. e. ) {D ©Q @ A W a 7. ; $ ~ [ Ppersistent

Ambient: |00 (3] |~

®
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®

Slicer4 Minute Tutorial: 3D Visualization

The model of the skin becomes
invisible in the 3D viewer.

(skin model opacity = 0.0)
(skull model opacity = 1.0)

# skull_bone.vtk

» Information

¥ Display

Visible:
Selected:
Clip:

Slice Intersecti
¥ Material Properties

Color:
7 Ta
Opadity: _— ‘ 0.00 [

Ambient:

Fva‘) QQ%A@E/ ;t' Persistent
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Slicer4 Minute Tutorial: 3D Visualization

®

Click on the Slice

Visibility
icon in the Green Slice
Viewer A

to display the Coronal
Slice in the 3D Viewer.

» Information

¥ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color: O

Opadity:
Ambient:
¥ Data Probe

L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

. | B i)
The Axial and Coronal | 7 B —

. . . | :-,0,\) DO s AP Hd ‘O‘t' Persistent H";h. v
Slices are displayed in | -<p:
the 3D Viewer. B

T
0
@
I
5
n

999999399
o o

Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: (o E

Ambient: === It
¥ Data Probe

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

Select the 3D model skull_bone.vtk in - — —
the Model Hierarchy and turn on the LI & b v st | @ A Fa | b~

Clipping option.

=} Scene
 hemisy ic_white_matter. v 1.00
® left_e B 100
* optic, v 1.00
* o Vi 1.00
= o v 1.00
& optic_tract_L.vi 1.00
® optic_tract_R.vi 1.00
# right_eyeball.v M 100
- Skin.v 0.00
>
» Information |
¥ Display |
Visible: v
Selected
H Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opacity: | 100 |5
Ambient: 000 %
¥ Data Probe
L
F
B
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®

Slicer4 Minute Tutorial: 3D Visualization

B rOWS e th ro u g h 8.0.gamma-2011-11-14

w Help

the coronal T N—C
slices to expose s

the 3D model of [

the white matter, ;-
and the leftand [ ¢
right optic
nerves. -,
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Slicer4 Minute Tutorial: 3D Visualization

Now make the skull
invisible.

[EIR X

=

bv J Q QO @ A w _@ A E ;‘ t ¥ | Persistent E Sta 'Eh'- e v

=} Scene

# hemispheric_white_matter.vtk 1.00
# |eft_eyeball.vtk B 100
# optic_chiasm.vtk 1.00
® optic_nerve_L.vtk 1.00
# optic_nerve_R.vtk 1.00
 optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
L+ skin.vtk 0.00

» Information |

v Display |

Visible:

Selected:

Clip:

Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: B ‘LOU =

Ambient: [0.00 k b/
¥ Data Probe

L

F

B
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Slicer4 Minute Tutorial: 3D Visualization

®

Scroll the Coronal Slices to display the

(2] E ]

hemispheric white matter model in the[,>.0 = © = + @ 2 - & ¢ t- = & « -

1

context of the image data in the 3D
Viewer.

[ |
7 5
29
i - /.‘ 4
3 S
1bf
U

N\
X A ¢
- ) (h F —
1.00 - S e
1.00 - %
.00 - —
1.00
M 100
0.00
0.00
¥ Display |
Visible: v
Selected:
Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opadity: 0.00 %
Ambient: 0‘00% b
¥ Data Probe
L
F
B

e v
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Slicer4 Minute Tutorial: 3D Visualization

Select the hemispheric white matter model called
hemispheric_white _matter.vtk

Turn off its visibility.

= Scene
L] ® he 100 |
* e B 100
> 1.00;
ol 1.00;
ol 1.00;
- 1.00
- 100
- B 100
> 0.00
# skull_bone.vtk 0.00
» Information
¥ Display
H Visible:
Selected:
Clip:
Slice I ection: bl
¥ Material Properties
Color:
Opacity: 1.00 |4
Ambient: 0.00 (51 (v
¥ Data Probe
L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

|

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.

®
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Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

®

File Edit View Help

/£ 3D Slicer 40.gamma-2011-11-14 ==
92 B | Modues: @ Models s - G. IO & A G 2 | 4 v persistent R So, -

Windows/Linux users: Position the
mouse in the 3D Viewer, hold down
the right mouse button and move| ..

the mouse down to zoom in.

puC_woTt L
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
® Skin.vtk

Mac users: Position the mouse in|
the 3D Viewer, hold down the apple
button and the mouse button and

move the mouse down to zoom in_

(or use two fingers on the touch™ " -
pad).

E
B
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®

Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

@ 3D Slicer 40.gamma-2011-11-14

O | B |3

File Edit View Help

FaN

@ 3DSlicer

» Help & Acknowledgement

Slicer displays a closer; ===~

view of 3D anatomical -
. it_eyeball.vtk B 100
structures overlaid on 2D - o

MR slices:

Visible:
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: e | 1,00 |5

Lt 5 Modues: @ Models s _v G- J Q (48] G A @ E 7 ; t v || Persistent o Ehv

Ambient: i—-———" I 1=k

¥ Data Probe

L
E
B

v
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®

Close the existing scene and all its data

Select File->Close
Scene

This removes any dataset
previously loaded into Slicer.

Select File-> Exit to exit the

software

2 3D Slicer 4.0.gamma-2011-11-14

& I :ne e ?OdEIS i _, 0, {D QD @ A W Z P &t 4 v [ persistent =% g@v -
Download Sample Data ®®

= AddData Ctrl+A

@ Add Volume

(2] Add Transform

th Save
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N Overview

Part lll: 3D interactive exploration of the anatomy
- Exploration of the Segments of the liver
- Exploration of the Segments of the lung

©2012-2013 Surgical Planning Laboratory, ARR Slide 82



Part Il:

Interactive 3D Visualization
of the segments of the liver
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Anatomy of the liver

Right Right Left Left
posterior anterior medial lateral
section section section section

Right hepatic vein

Umbilical vein
(remnant)

Hepatic duct
Inferior vena cava

Cystic

Hepatic artery
duct

Portal vein

Gall bladder Bile duct
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‘ﬁb Liver dataset

The liver dataset is

a contrast-enhanced CT
abdominal scan of a
healthy 36 year-old male.
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3D segments of the liver

®

~ __ SegmentlVa

''''''

Segment VI Segment Il

Segment VI - Segmentlil

Segment V ~ Segment [Vb .
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ﬁ' 3D segments of the liver

|
Segment | | Segment |

Segment Il
Segment Vb Ve | *=" Segment VI

| ==

3 S_ngment V
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Liver vasculature

Middle Left portal .
AERENT Vel vein = Left hepatic

q T vein
Rig ht pOrtaI | : ' ) S - ~‘:- \.- .I‘.I_-‘_::‘-""'/:'.'; :,—i:’,{( \::ﬂf; - | "i
i SRR SR & Caudate vein | =

Vel gk iy o h “— ‘

——
—

o

e

Main portal

Right hepatic gt
vein

©2012-2013 Surgical Planning Laboratory, ARR Slide 88



Loading the Liver Data Scene

e o e S SICRE 4.2 D 1200 21 (2R
File Edit View Help
g2 2 2 Modules: - |aWelcome to Slicer EREIL XN tolE -

e®

Welcome

=& Load DICOM Data || i Load Data
# Customize Slicer | © Download Sample Data |

» About
» The Main Window

» Display

» Mouse & Keyboard

l

I

|» Loading and Saving
\

\

| » Documentation & Tutorials
{

l
l
|
|
|
\
|

» Acknowledgment

70001~ Y @ (- R:0.00[8 G A:0.00

Re-start Slicer, and click on
the Load Data icon

|~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Loading the Liver Scene

3D Slicer 4.0.gamma-2011-11-
"0 Q@ @ s§E 2 | ¢ v Persistent | [ fw o -
o= HI

A
AN /
AN /

eeeeeeeeeeeeeeeeeeeee

Browse to the directory
C:\Pujol2012\3Dvisualization_Tuesday Nov27 2012
Select the directory dataset3 CT-Liver

Select the file LiverSegments_Scene.mrmi

Click on OK to load the scene into Slicer
E e O
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Liver Segments Scene

®

The elements of the scene appear in the Viewer
\@msucer S

Welcome
s, Load DICOM Data | o Load Data |
Gaw Load Data || @ D: Data |
» About

> The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

wmr
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o) 3D models of the liver

~ Segment |Va

-----

Segment VI Segment Il

Segment VI ~ SegmentlIl

Segment V ~ Segment [Vb =
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]
|
i

.ﬁb 3D models of the liver

Segment |

Segment ’I Segment VII

Segment | ‘
Segment IVb |y | *~ Segment VI

: -

3 S—e;gment V
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oi¢? 3D models of the liver

Middle Left portal § E i

AEDENE HEll , W= |eft hepatic
Right portal F oy s 50 00 o o *
vein R W ﬁl CaudaE/ein I R

Main portal

Right hepatic gati
vein -l
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ﬁ' 3D EXxploration of Liver Segments

Example:
What organ abuts the
left-most margin of
segment Il in this
patient ?
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3D Exploration of Liver Segments

3D

,,

@ # MByes: JM.QO DO ws9HE
ex [l

@BDSIicer

[» Help & Acknowledgement

®

D]

= Scene

= Liver Structures Models

= Vessels

» [VC [ |
= MainPortalVein
= LeftHepaticVein_and_Branches M
« MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
= CaudateVeins
gments
= LiverSegment_lI
= LiverSegment_|II
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
LiverSegmentVI
LiverSegmentVIl

EEEEEEEE

EEEETEE
EEEEEEEEE

| » Informg8lon

[~ Display
Visible:
Selected:
Clip:
Sliceg'

_ Select the module Models
. Click on the Liver Structures Models Hierarchy

= SRV an7e
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3D Exploration of Liver Segments

8006 3D Slicer 4.0.gamma-2011-11-24

& & Modules: . [@ Models " 00N @« A 9@ -E ‘E‘ 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement

> @ R R | 4~

I»)

= Scene
= Liver Structures Models
= Vessels
= [VC | |
= MainPortalVein
» LeftHepaticVein_and_Branches |
= MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches

Sobobodoatot
88888888

Nerpegmomsl] 1] i

= LiverSegment_IVa B 1.00
= LiverSegment_IVb W 100
= LiverSegment_| 1.00
= LiverSegment_VIII B 1.00
= LiverSegmentV | 1.00
= LiverSegmentVI W 1.00
= LiverSegmentVIl o 1.00

» Information

~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Select the model Liver_Segment |l
Turn on/off its visibility to locate

Color: [ ] \
~ Data Probe

wmr

e it in the 3D viewer.
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3D Exploration of Liver Segments

®

8no 3D Slicer 4.0.gamma-2011-11-24
% & [Modules: . |@Models = QOO @« A @ H » o 4~
1
r‘\ 3DSlicer

4
» Help & Acknowledgement

Position the mouse in
the 3D Viewer, hold
down the left mouse
button and drag to &\ /e
orient the 3D model to N — 4
a superior view. G e —

L
F
B
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gamma-2011-11-24

@ & |Modules: . [@Models OO0 IO & A@Ed PN B4 » Ao Ra v

Q 3DSlicer

» Help & Acknowledgement

= Scene
= Liver Structures Models
= Vessels

IVC | 10

MainPortalVein 1.0

LeftHepaticVein_and_Branches 1.0

MiddleHepaticVein_and_Bran... [ 1.0

RightHepaticVein_and_Branc... } 8
1.0
1.0

9

4999

» LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
» CaudateVeins

g

[ellot=lot=ToT =]

= LiverSegment_IIl
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
= LiverSegmentVI
= LiverSegmentVII

EEETEN
[elelololotatal
[SIStStSISIStSts!

» Information |

~ Display |
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: &
~ Data Probe

What organ abuts the left-
most margin of segment Il

@wmr
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gar
& & |Modules: . [@Models Q0 IN® e 4 @H

Question 1:

mma-2011-11-24
» ol ¢~

What organ abuts the left-

most margin of segment Il
in this patient?

Answer 1: Stomach

lice Lnter_sections V_isnble:
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3D Exploration of Liver Segments

XX 3D Slicer 4.0.gamma-2011-11-24
@ & |Modules: . [@ Models "m0 IO e 42 @E » PRI Y » fa fa, -
1
eO®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the

right adrenal gland ?

w i
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3D Exploratlon of leer Segments

8 0o 0.gamma-.

@ & |Modules: . [@Models :—Q\){DO@K\WQ I,O't
@®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the
right adrenal gland ? —
Answer 2: Segment VI

00000000
[slelstetototots]

-e

EEETEE
0000000 Y
[SIStSiStstSIsts|

W
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‘ﬁ' 3D Exploration of Liver Segments

~ Question 3:

" B \Which vessel separates
Segment Vb and
Segment V?

e
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Middle Hepatic Vein

000 3D Slicer 4.0.gamma-2011-11-24 u
& Modules: . [@Models =0 QI ® @« 4 @& 5\ t- | Mlddle
o= [l
@ 3DSlicer
v

| » Help & Acknowledgement |8
= Scene
= Liver Structures Models

= Vessels
o IVC m 1.00
< MainPortalVein 1.00
< LeftHepaticVein_and_Branches M 1.00
= MiddleHepaticVein_and_Bran... [§ 1.00
< RightHepaticVein_and_Branc... 1.00
< LeftPortalVein_and_Branches 1.00
< RightPortalVein_and_Branches 1.00
« CaudateVeins 1.00

= Segments
< LiverSegment_I|

-
Q9
S

< LiverSegment_llI

< LiverSegment_IVa

LiverSegment_IVb

LiverSegment_|

LiverSeg mentVVI 1l
I

-
LiverSegmentVI|
< LiverSegmentVII

|» Information |

| ~ Display

\liniklA- >

Question 3:
Which vessel separates Segment IVb and Segment V?
Answer 3: The middle hepatic vein

=



Closing the Liver Scene

8eno 3D Slicer 4.0.gamma-2011-11-24

% # |Modules: (@ Models ]-eo DO e@sA@Z - Eelt- > @ A R |4

!" 3pSlicer
4

| » Help & Acknowledgement

= Scene
= Liver Structures Models
ERVZ-INVNIN

< HigntPortalvein_anda_bBranches
< CaudateVeins
= Segments
< LiverSegment_II
< LiverSegment_llI
< LiverSegment_IVa
= LiverSegment IVb
< LiverSegment_|

LiverSegment_ VIII

Liver! egmentVI
LiverSegmentVII

|» Information

| ~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: [ (]
| ~ Data Probe

wmr
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Interactive 3D Visualization
of the segments of the lungs
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®

Segments of the lung

Segmentation and 3D surface
reconstruction of the lung and
pulmonary vessels

Acknowledgment:

Segmentation of the lung surface and vasculature: Raul
San Jose Estepar, Ph.D., George Washko, M.D., Ed
Silverman, M.D. and James Ross, MSc. Brigham and
Women'’s Hospital (K25 HL104085) and COPDGene (01
HL089897 and U01 HL089856)
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N Segments of the lung

3D parcellation of arteries and veins from

original model of pulmonary vessels
(Kitt Shaffer, M.D., Ph.D. - Sonia Pujol, Ph.D.)

- Right Upper Lobe (RUL)
- RUL Pulmonary Vein
- RUL Anterior Segment
- RUL Apical Segment
- RUL Posterior Segment
- Right Middle Lobe (RML)
- RML Pulmonary Vein 1 & 2
- RML Lateral Segment
-  RML Medial Segment
- nght Lower Lobe (RLL)
RLL Pulmonary Vein 1,2,3
- RLL Anterior Basal Segment
- RLL Medial Basal Segment
- RLL Lateral Basal Segment
©2012-2013 Surgical Planning Laboratory, ARR -  RLL Posterior Basal Segment




Loading the Chest Data Scene

800

3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga & % Modules: . [Welcome to Slicer (=0 Q9 «@ ~ t v @ A R
o= @
e 3DSlicer
Welcome
wéw Load DICOM Data || e Load Data ]

[ #Customize Slicer || @ Download Sample Data|

» About
» The Main Window

» Loading and Saving

» Mouse & Keyboard

» Documentation & Tutorials

l
|
l
» Display J
l
I
l

» Acknowledgment

|~ Data Probe

L
E
B

None RAS: (125.0, -125.0, 1.0),
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Loading the Lung Scene

A9 4 & § v Persistent | @ fm R

Click oanﬁgose Files and browse to the directory
C:\Pujol2012\3DVisualization_Tuesday Nov27 2012
Select the subdirectory dataset4 CT-Chest

Select the file LungSegment_Scene.mrml

Click on Open

Click on OK to load the scene in Slicer



Loading the Lung Scene

0o
& & |Modules: . Welcome to Slicer OO0 D Ogs 4
e CIH

P : .
@ 3DSlicer R L E‘;la‘;
A [s]wad]e
Welcome
Load DICOM Data [y Load Data

@ Load Volume Data || @ Download Sample Data

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Kevboard

Position the mouse cursor in the
top left corner of the 3D viewer,
and select the top left icon to
center the 3D view on the scene

[ss Ryl
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Loading the Lung Scene

800

3D Slicer 4.0.gamma-2011-11-24
2 & [Modules: - |Welcome to Slicer S

d= 00N e s @2 ~EHlelt-
\ansncer
w

e HA
Welcome

( Load DICOM Data || Load Data J
[ Load Volume Data || @ Download

ple Data |

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

Select the module Models from
the modules Menu.

~ Data Probe

W
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ung Segments

& Slicer File Edit View Help GO M D ) & 548PM Q
8006 3D Slicer 4.0.gamma-2011-11-24
& [Modules: . [@Models =00 IO e« A9 HE » @l 4~ > @ A fa | v

e [l

@ 3DSlicer

[» Help & Acknowledgement =

= Scene
» chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
= RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1
= RightLowerlLobe_PosteriorBasalSegment
= RightLowerLobeMedialBasalSegmen
= RightLowerLobeAnteriorBasalSegment
= RightLowerLobe_LateralBasalSegment
= RightLowerLobe_PulmonaryVein4

Slicer displays the list of 15
surface models of pulmonary
structures.

ENNEEEEEEEENNEEEE
P e e e e
§8888888888888888%

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v

Color:
Opacity: [
| ~ Data Probe

wmnr
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Lung Segments — Question 1

@ Slicer File Edit View Help GO MM = ) & 423PM Q
800 BRiSlicendi0icammas2 D114
@ & [Modules: . (@ Models DR 5) {D O @ A @ [ER @ t~

@®

@ 3DSlicer

[» Help & Acknowledgement

= Scene
< chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
- HightLowerLobe,SuFeriorSe ment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1

thtLowerLobe Posterlor asalSegment

EEEEEEEENNEEEE
8F3883358833585%

[» Information

[~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: ( []

]
Opacity: 711.00 |

Amhiant: ) nnn i«
|~ Data Probe

T
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Lung Segments — Question 2

@ Slicer File Edit View Help GO M = 4) G 425PM Q
800 3D Slicer 4.0.gamma-2011-11-24

%2 & Modules: - | @ Models

!l; 3pSlicer
4

| » Help & Acknowledgement

= Scene

.. _chestCI_lungs
RightUpperLobe_Pulmo...
RightUpperLobe_Poster.
RightUpperLobe_Apical.
RightUpperLobe_Anteri...
RightMiddleLobe_Pulm...
RightMiddleLobe_Later...
RightMiddleLobeMedial...
RightMiddeLobe_Pulmo.
RightLowerlLobe_Superi.
RightLowerLobe_Pulmo...
RightLowerLobe_Pulmo...
RightLowerLobe_Pulmo...
RightLowerLobe_Poster...
= RightLowerLobeMedial...
= RightLowerLobeAnterior...

9939999999999
ottt
[elelelololololololololololo]e)
[slelslslslolslslolslololalala) A

| » Information

|~ Disolav

Question 2:Which
segment’s vascular
supply is shown at the
arrow?
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Lung Segments — Question 2

@ Slicer File Edit View Help GO M D 4) GF 425PM Q
800 3D Slicer 4.0.gamma-2011-11-24

& & |Modules: . [@Models "0 O INO @si@R » o)t~

@ 3DSlicer
4

| » Help & Acknowledgement

> @ R R4

= Scene

.. _chestCI_lungs

= RightUpperLobe_Pulmo...
= RightUpperLobe_Poster...
= RightUpperLobe_Apical...
= RightUpperLobe_Anteri...
= RightMiddleLobe_Pulm...
= RightMiddleLobe_Later...
= RightMiddleLobeMedial...
= RightMiddeLobe_Pulmo...
= RightLowerLobe_Superi...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Poster...
= RightLowerLobeMedial...
= RightLowerLobeAnterior...

Question 2:Which segment’s
vascular supply is shown at
the arrow?

Answer 2: Right Upper Lobe
Apical Segment

EEEn

aaaaaaaaaaaaaaafe
[eletotololotototolototoYotote)
[eleleletotelelolotototot ookl ]
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Lung Segments — Question 3

& # |Modules: —-OO O e s P

@ 3DSlicer

Help & Acknowledgement

= Scene
# chestCT_lungs
- nghtUpperLobe PulmonaryVein
htU Lob

per|
- nghtMlddIeLo ulmonaryVein
» RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddeLobe_PulmonaryVein2
- nghtLowerLobe_Sur)erlorSe ment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1
- nghtLowerLobe Posterlor asaISe

©2012-2013 Surgical Planning Laboratory, ARR Slide 117




Lung Segments — Question 3

8006 3D Slicer 4.0.gamma-2011-
& [Modules: . [@ Models S| -

9®
@ 3DSlicer

» Help & Acknowledgement

= Scene
» chestCT_lungs
» RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddeLobe_PulmonaryVein2
» RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
< RightLowerLobe_Pulmonar: \'/ein2
- R e_Pu
< RightLowerLobe_PosteriorBasalSe...
= RightLowerLobeMedialBasalSegmen
» RiahtLowerLobeAnteriorBasalSea. ..

Question 3:Which
segment’s vascular supply
iIs shown at the arrow?
Answer 3: Right Lower
Lobe Pulmonary Vein 1

11-24

D}

[slelelelalalalele).]

bgb'obb‘o'o'obb'—n
S

FQIFGEN _ PN o

8885
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ung Segments — Question 4

@& Slicer File Edit View Help PRl 440PM Q

@ & [Modules: . (@ Models

@ 3DSlicer

[» Help & Acknowledgement
L

»&&v+v

= Scene
= chestCT_lungs
< RightUpperLobe_PulmonaryVein 1l
< RightUpperLobe_PosteriorSegment
< RightUpperLobe_ApicalSegment
< RightUpperLobe_AnteriorSegment
« RightMiddleLobe_PulmonaryVein
< RightMiddleLobe_LateralSegment
< RightMiddleLobeMedialSegment
< RightMiddeLobe_PulmonaryVein2
= RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
- RightLowerLobe_Pulmonar Veint W

©

8853358885553

~ Data Probe

T
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Lung Segments — Question 4

® Slicer File Edit View Help

442PM Q

& & [Modules: . [@ Models dm QOO e sA@@ -Hlet- > B Ae R | v

& Smallest: Medial Basal

[» Help & Acknowledgement 4]
L

= Scene

= chestCT_lungs

< RightUpperLobe_PulmonaryVein
< RightUpperLobe_PosteriorSegment
< RightUpperLobe_ApicalSegment
< RightUpperLobe_AnteriorSegment
< RightMiddleLobe_PulmonaryVein
< RightMiddleLobe_LateralSegment
< RightMiddleLobeMedialSegment
« RightMiddeLobe_PulmonaryVein2
< RightLowerLobe_SuperiorSegment
< RightLowerLobe_PulmonaryVein3
< RightLowerLobe_PulmonaryVein2

< RightLowerLobe_PulmonaryVein1

< RightLowerLobe_PosteriorBasalS
= RightLowerLobeMedialBasalSeg

EEEEETEEEEE
=33585358535855585

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Color: ( ] |
Opacity:
[~ Data Probe ]

l
(T

wmrr



Lung Segments — Question 4

® Slicer File Edit View Help GO M = ) & 443PM Q
8006 3D Slicer 4.0.gamma-2011-11-24
& & |Modules: . [@Models " QO ® e s @@ ~Eo t- »| B A fe | 4~

el

Largest: Anterior / Posterior
Basal

@ 3DSlicer

[» Help & Acknowledgement B

= Scene

= chestCT_lungs
RightUpperLobe_PulmonaryVein
RightUpperLobe_PosteriorSegment
RightUpperLobe_ApicalSegment
RightUpperLobe_AnteriorSegment
< RightMiddleLobe_PulmonaryVein
< RightMiddleLobe_LateralSegment
< RightMiddleLobeMedialSegment
< RightMiddeLobe_PulmonaryVein2

< RightLowerlLobe SuFeriorSe ment

000

0

< RightLowerLobe_PulmonaryVein3
< RightLowerLobe_PulmonaryVein2
< RightLowerLobe_PulmonaryVein1
= RightLowerLobe_PosteriorBasalS
53 tLowerLobeMedialBasalSe
tLowerLobeAnteriorBasalSeg

LowerLobe. teralBaseIS

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Color: ( [] )
Opacity:
[~ Data Probe

mmr

D e e LRI B e R Tl S SRR LI U R R A =



3D Visualization of DICOM images

 Interactive user-interface to
load and manipulate
greyscale volumes,
labelmaps and 3D models.

» User-defined 3D view of the
anatomy

« 3D Open-source platform for
Linux, Mac and Windows
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3DSlicer website

Search L

3051 A multi-platform, free and open source software package for
DSlicer visualization and medical image computing

Slicer Wiki

About Slicer
»Introduction
»Acknowledgments
»Contact Us

Resources
Download

»For Users

»For Developers
»Commercial Use
*NCIA
»Publication DB
»Image Gallery
»Slicer Community
»Source Code
»Licensing
»Mailing Lists
»Web Archive

4

The community of Slicer developers is proud to announce the release of Slicer 4.2. Find out more...

Webinar: Introduction to Slicer 4.1

Content of this site is Copyright 2012 BWH and 3D Slicer contributors, unless otherwise noted.
Contact webmaster@bwh.harvard.edu for questions about the use of this site's content.
See here for more information about the web infrastructure.
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NIH/NCI Cancer Imaging Archive Course

The NIH/NCI Cancer Imaging Archive (TCIA): A Comprehensive
Source of DICOM Imaging Data for Research

C. Carl Jaffe MD, John B. Freymann BS, Justin Kirby, Fred William
Prior, PhD, Lawrence R. Tarbox PhD

Wed. Nov. 28, 10:30 am — 12:00 pm SCD 401
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Upcoming Slicer courses

®

SPIE Y LA 59-14February20@13 = \1’ SPIE 2013’ Orlando’ Florida

Medical Imaging s e Greve s Cars 2013, Heidelberg, Germany

Florida, United States

bt home | contact | imprint | sitemap
i
latest, cutting-edge research and develc i
you are presenting to your peers, or you = r}m
that will enhance your research, this co iiiiiE, 4 i

CARS 2013

Computer Assisted Radiology and Surgery Download the
27" International Congress and Exhibition

Plan to attend this multidisciplinary, inf
June 26-29, 2013

Heidelberg, Germany BB o
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Upcoming Slicer courses

ECR
2013

g

(Scerna
March 7-11

The IMAGINE sessions give research institutes, university groups and companies a

Preliminary chance to present their novel technological developments in medical image
Programme

analysis and image-guided interventions to the radiology community.

Be part of it! Submit your abstract to be in with a chance to present it to the right
audience.

The core of the IMAGINE sessions are interactive sessions in which the presenters
demonstrate their work and visitors get hands-on experience with developed
techniques and tools.

The session topics will describe novel techniques in one of the following areas:
o Quantitative Image Analysis @
o Computer-aided Diagnosis

o Image-guided Interventions

o Image Processing
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www.slicer.org
WWW.Na-mic.org

Questions and comments: spujol@bwh.harvard.edu
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